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Requirements  
 

A computer system running Windows with: 

•a sound card installed; 

•a CD-Writer installed; 

•music source; 

•Wave Creator Version 3.0 or greater 

 

 

THE COMPUTER 

 

Hardware requirement: 

It must be a Pentium class machine. 

It must have a sound card, preferably SoundBlaster compatible. 

If you intend to extract (“rip”) your music from CDs, then it must have a CD-ROM (or CD-RW, DVD+CD-RW) drive. 

If you intend to write (“burn”) CDs, then it must have a CD-writer (“CD burner”). 

The sound card and the required CD-drives must be installed and running. 

The CD drive must support digital audio extraction if you want to “rip” the music from a CD. 

 

Software requirement: 

The operating system may be any one of the following: Microsoft Windows 98, ME, 2000, or XP. 

If you intend to Decode or Encode MP3 files, then you need a special software program called a codec (short for compressor-

decompressor, or, coder-decoder). Two popular codecs are the Fraunhofer codec (Professional or Advanced) and the LAME encoder.  

If you intend to “burn” CDs, then you will need to have CD burning software. The Adaptec CD-burning plugin (software) can be 

obtained for free on the web. When you first run Wave Creator, the software will determine if you need to download any software 

components. If so, it will point you to a website from where you may download the required components. 
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Introduction  
 

Features: 

 

• Extract digital copies of the songs from your CDs 

• Capture the output of any electronic audio equipment 

• Convert from analog audio sources to state-of-the-art digital audio format 

• Make backup copies of your precious music collection - vinyl LPs, tapes, videos, and similar media. 

• Store the songs in all major computer-readable digital audio formats like Wave, MP3, and RealAudio 

• Edit (cut, copy, paste, mix) the songs, limited only by your creativity and requirement 

• Apply  special sound effects through a full range of plug-ins 

• Store your musical creations on CDs. 

• Record live performance  

• Access online help, Web-based tutorials, and discussion groups 

 

Wave Creator offers ease-of-use, low cost, and tight integration that's hard to beat. We think you'll have a great time with Wave Creator 

and begin to look at your music collection in a whole new way. Enjoy! 

 

 

Installation  
 

To install this program, run the installation program (named Wave Creator.EXE or Wave CreatorTrial.EXE) that you downloaded or 

received on disk and then follow the on-screen instructions.  

To begin the interactive installation process: 

  

  1. Point at the installation file with the mouse pointer, and double-click the icon representing the Wave Creator installation file.  

 

  2. In most cases the installation program itself comes up with suitable values required to install the Wave Creator program. You are 

strongly advised to accept the normal values presented by the installation program. 

 

  3. On completion of its tasks, the installation program displays a message informing you that the installation process is complete. 

Wave Creator is now ready for use! 

 

 

The installation program creates two shortcuts: one is placed in the group of startup programs, and the other is placed on the desktop.  

 

If you need help with this please consult your computer manual or send an e-mail to 

support@blazeaudio.com!EF(`mailto:support@blazeaudio.com',`',1. 
 

Starting Wave Creator  
 

There are three ways to start the program. 

• Look for the program icon on the desktop. If it is there, move the mouse pointer to the icon, and double-click it. 

• Click the Start button, then click Programs. Look for an item captioned Blaze Audio. If it is there, click it. Now look for an item 

captioned Wave Creator in the list, and if you find it, click it. This will reveal the 3 sub-components of Wave Creator. The first is the 

program itself. Click it. The program will start running. 

• Click the Start button, then click Run. A small dialog box will be displayed. Type in the name of the program (REB32.EXE) and click 

the OK button. This may require you to enter the path to the program. 
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 Editing_________ 

 

Edit Window Overview  
 

 

 

 
 

The Menu System  
 

The menus show lists of functions, operations, and choices available in the program.  

 

.   

 

The menu is shown as a bar across the top of the program window. This bar contains a number of captions, each caption representing an 

option of the menu system. Select an option by moving the mouse pointer to the appropriate caption and clicking the (left) mouse button. 

Further options (if any) are displayed as a sub-list or submenu. 

Other ways to activate a menu option: 

Each of the menu captions contains an underlined letter, e.g. the letter T (in the Tools menu option) is underlined. A menu option may be 

activated by pressing the Alt-key (Alternate key) simultaneously with the key of the underlined letter. 

NOTE! Not all menu options are assigned shortcuts. 

 

FILE OPTIONS 

New  
 

Location: File Menu 
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Use the New command to create a fresh workspace in Wave Creator's memory. Wave Creator will prompt you to enter format 

specifications for the new workspace such as sampling rate, bit rate (sample resolution), and number of channels.  

The sampling rate (ranging from 8000 Hz (samples per second) to 96000 Hz) can be selected from a list of sampling rates. The bit rate 

(or bit depth or sample resolution) can be set at either 8- or 16-bits per sample. The user can select between monophonic (1 channel) and 

stereophonic (2 channels) modes of operation. Click the OK command button to confirm the settings and proceed, or click the Cancel 

command button to back out. The default name for this workspace is Untitled-n.WAV where n stands for a number. 

 

Note: It is not necessary to use this command when you first start Wave Creator, as the program's memory will already be empty. This is 

unlike a program such as Microsoft Word where you must create a new document before you can begin editing. With Wave Creator, a 

blank audio document is already ready for you as soon as you start the program. 

 

Every time you click the New button a fresh workspace will be created and assigned for use. 

Multiple workspaces (audio files) can be opened simultaneously.  

 

Open  
 

Shortcut: Control-O 

Location: File Menu 

 

To open a Wave File: 

 

To load a previously saved Wave-format file into Wave Creator's memory, use "File/Open" menu option. You will see "Open dialog 

box".  Select "Wav" in the File type combo box on the open dialog box, and select a “Wave” file to open. 

Wave Creator allots a workspace for this file. Wave Creator can open standard Wave files in a variety of formats -- 8 or 16 bit; 11, 22, or 

44 KHz; and stereo or mono files. By default, Wave Creator looks only for files with the .WAV extension. 

You can open as many files and workspaces as you want simultaneously.  

The name of the file associated with each workspace appears in a separate tab in the Workspace Status Bar along the bottom of the 

program window. Only one workspace can be the primary workspace at a time. A white background indicates the primary workspace, a 

gray background indicates a non-primary workspace. Clicking the workspace tab makes it the primary workspace. As each file is opened, 

it is automatically granted the primary workspace status. 

 

You can go into full screen mode whilst editing your audio file! Just  go to the View menu option, and click the "Full screen" sub-option! 

To revert, click the "Minimum size" sub-option of the View menu option. 

 

To open an MP3 File: 

 

 RipEditBurn allows you to open MP3 files directly into its edit interface for editing. 

 

To load a previously saved MP3-format file into RipEditBurn's memory, use the "File/Open" menu option.  In the "Open” dialog box, 

select "MP3" in the “Files of Type” combo box, and select an MP3 file to open. 

 

The specified MP3 file is converted into a Wave-format file, and it is this Wave-format file which is presented for editing in its own 

workspace.  

 

In order to open the MP3 format audio files, you will need a supported MP3 'codec' to be installed on your computer. See p. 41 for more 

information about MP3 codecs, which codecs are supported by RipEditBurn, and how you can obtain a codec if you don't have one. 

 

See the Definitions chapter (p. 39) for more information about: 

Wave and MP3 formats  

Quality after A-D conversion 

 

Save  
 

Shortcut: Control-S 

Location: File Menu 

 

Select Save to write audio data of the primary (currently selected) workspace to disk in the Wave or MP3 format.  

If you have not yet specified a file name, Wave Creator will prompt you for a file name and location. If you have already specified the 

file, Wave Creator will not ask you again for the location. 

If there is more than one workspace open, you can make any one the primary workspace simply by clicking on the appropriate tab which 

appears along the bottom of the program window.  
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Save will not be enabled unless you have audio data in memory. 

 

Save As  
 

Location: File Menu 

 

Use Save As to save the contents of the primary workspace as a Wave or MP3 format file with a new name and/or in a new location.  

After you select Save As, RipEditBurn will open a “Save As” dialog box, prompt you for a filename, file type,  and location. 

The default file type selected in the “Save As” dialog box is "Wave". 

 

To save as MP3: 

 

In order to save audio to the MP3 format, you will need a supported MP3 codec to be installed on your computer.  

For more information about MP3 codecs, which codecs are supported by RipEditBurn, and how you can obtain a codec if you don't have 

one, see the Definitions section of this manual. 

 

To save a file to MP3 format, choose File/Save As, select "MP3" in the “Save as Type”  box in the “Save As” dialog box, and specify the 

name and location to save the MP3 file.  RipEditBurn will convert the data of the Wave-format file to an MP3-format file and save the 

converted file.  The "MP3 Conversion" dialog box prompts you to select the Codec (see p. 41 for definition) and encoding bitrate, and 

saves your Wave-format audio files into the compressed MP3 format.  

The higher the compression bitrate, the better is the quality of the MP3 audio, but the larger the size of the converted file. 

 

More information on Wave and MP3 formats and Quality after A-D conversion can also be found in the Definitions section of this 

manual. 

 

 

Import from WMA 
Location: File Menu 

 

This option allows you to import WMA files directly into Wave Creator's edit interface for editing. 

 

The specified WMA-format file is converted into a Wave-format file, and it is this Wave-format file which is presented for editing in its 

own workspace.  

 

In order to Import WMA format audio file to Wave format, you will need "Windows Media codec9" to be installed on your computer. 

For more information about how you can obtain a codec if you don't have one, go to 

http://www.blazeaudio.com/wmasupport/. 

 

Export to Real Audio/WMA  
 

Location: File Menu 

 

This option allows you to "export" a Wave-format file. This actually means that you can convert the data of the Wave-format file to a 

RealAudio format file and save the converted file. 

Clicking this option presents you with the choice of RealAudio format. 

Click "To RealAudio" to convert to and save in the RealAudio format. 

The RealAudio format  is a "streaming" audio format that is particularly good for use on the Internet, as it allows listeners to hear the 

audio as it is downloaded, rather than having to wait for the entire file to download before playback. The RealAudio format is also highly 

compressed, so it downloads much more quickly than wave audio. 

 

In the “Export to RealAudio” window, optionally enter a Title, Author, and Copyright, and click on Browser to select an export path and 

filename. You may also choose to enable selective record, and/or perfect play. For more information on these options see the RealAudio 

website at www.real.com. 
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Export to WMA 
 
Blaze Audio's RipEditBurn provides a fast and easy-to-use method for converting WAV and MP3 files to WMA files (Windows Media 

Audio files with a .wma extension)  

This option allows you to export a Wave/MP3 format file to WMA format.  This actually means that you can convert the data of the 

Wave/MP3 format file to a "Windows Media Audio" format file and save the converted file. 

In order to Export audio to the WMA format, you will need "Windows Media codec9" to be installed on your computer (see p. 41-42 or 

visit http://www.blazeaudio.com/wmasupport/ for information on downloading plug-ins).  
 

Clicking File/Export opens a flyout box allowing you to choose RealAudio format or WMA format.   

Clicking “to WMA” opens the "Export Sound to WMA" dialog box.   

  In the WMA Filename window,  leave the file name and path as they appear in the window, or click on Browse to specify  

  the name and path of your choice. 

  In the Encoder window, select the correct encoder. 

  In the Output Format window, you will select the WMA Profile. The WMA Profile defines the bitrate in Kbps, sampling rate in 

  KHz, and the channel into which WMA files are converted.  Windows Media Audio format is a compressed format; the higher the 

  compression bitrate, the better the quality of the WMA audio, but the larger the size of the converted file. From the dropdown 

  menu, choose the preferred encoding bitrate, sample rate and Stereo/Mono option for the output WMA file.   Possible sample 

  rates are restricted by chosen bitrate, and possible channels' modes are restricted by the chosen bitrate and samplerate.  

 

Click the "Export" button to start WMA conversion. 

 

Change Song Information 
 

Shortcut: Control-I 

Location: File Menu 

Use "File/ Change Song Information.." menu option, it would open " Enter Song Information " dialog box. A button “Change Song 

Info...” is also provide on the REB in Edit mode. 

 

For Mp3 files the “Song Information” is stored in the form of ID3 tag. 

For Wave files, the “Song Information” is stored in proprietary format. 

 

The ID3 information will be saved in the file when user selects "Save" option from file menu. 

 

In case user selects "Save As" or “Save” a file for the first time, a message box will appear, asking if User wants to add ID3 information. 

 

 
 

If user selects "Yes" then it will display "song Information" dialog box and will allow the user to "enter/modify" ID3 information. 

 

If user selects "No" then it will simply save the file. Note that in case of Save As if user selects "No" and if the original file contains any 

ID3 information, then that will be copied to the new file specified in "Save As". 

If user opens a file and selects the "Change Song Information..", it will display ID3 information stored in the file. 

 

Editing Song Information (ID3 Tag)  

To edit "Song Information" (ID3 Tags) in MP3, or Wave file, Open a Wave/MP3 file in REB Editor, 

click on "File/ Change song Information" menu item. 

An "Enter song Information" dialog box will appear. 

This dialog box is showing up following fields. 

"Title", "Track No", "Artist", "Year", "Album", "Link", "Genre", "Copyright", "Language", "Composer", and "Comment". 

If the opened file already having the "Song Information", the dialog box will show it in the corresponding fields. 

You can now change ID3 Tag fields of current opened file,  

If a new file is opened or opened file does not have any "song Information" yet, the dialog box will appear empty. 
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Edit / Enter the song information in this dialog box and click OK to keep the changes. 

If you wish to cancel the changes, Press "Cancel" button on this dialog box. 

Note that until now you have changed the "Song Information", but it is not saved.  

If you want to save your changes, Exercise File/Save option to save the "Song Information" with the opened file. 

If you have opened several files in REB editor, you can edit the "Song Information" for the currently Active file. 

Whenever you want to "Save As" a file in Wave or MP3 format, a message will prompt you to Enter the "Song Information" 

"Do you want to enter/modify song information?" With "Yes" and "No" buttons. 

If you choose "Yes" on this message, Wave Creator would open the "Enter Song Information" dialog box for the current file. after 

entering the "Song Information", and click OK on this dialog box, "Save As" dialog box will appear prompting to save this file as Wave 

or MP3 file. 

 

Close 
  
Location: File Menu 

 

Use Close to close the file in the primary workspace in Wave Creator's memory. If the file has not been saved to disk, Wave Creator will 

ask if you would like to do this before closing the file. If you do not save the file to disk, all changes (from the last save operation 

onwards) will be lost. 

 

Revert  
 

Location: File Menu 

 

The Revert sub-option discards the contents of the primary workspace and reloads the workspace with the contents of the last saved 

version of the disk file. 

This option is disabled if: 

1) the primary workspace is absolutely new; 

2) the data in the primary workspace has not been saved to disk as yet; 

3) as far as the propgram can tell, the user has not modified the data in the primary workspace since the time it was last saved. 

Preferences  
 

Location: File Menu 

 

Selecting Preferences brings up a dialog box that will allow you to make changes to Wave Creator's configuration. The dialog box 

presents you with two tabbed pages.  

The first page is captioned "General". This page allows you to set the folder to hold temporary files used by Wave Creator. The default is 

the Temp (temporary) folder maintained by Windows. The second thing on this page is a check box captioned: Always Show Test 

Levels. If you set this option (tick it), then the LED level-meter monitors the selected recording source, even if you are not in recording 

mode. If this option is cleared (unmarked), then the LED level-meter will not monitor the selected recording source unless you are in 

recording mode.  

The second tabbed page is captioned "Devices". This page lets you select the Playback and Recording device that you want to use. This is 

useful in a multi-user setup, where a system may have multiple multimedia devices installed. This option is dependent on the devices 

(and their drivers) that you have installed in your computer system. 

 

Exit  
 

Location: File Menu 

 

Click this to terminate the program. 

This is the preferred method to end the program. When you click this option, the program clears up its temporary work areas, and frees 

up system resources which were allotted to it. If you have one or more workspaces with unsaved data, the program will prompt you to 

save them one by one. You may selectively save the workspaces and assign them names if you have not already. 

 

Recent Files  
 

This is a list of files which have been loaded into Wave Creator. The latest 10 files are registered here. 
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This is convenient for the user. Now the user can select a file from this list, and click on its name to load it into the primary workspace. 

Alternatively, he can simply key in the digit indicating the file to load it into Wave Creator's memory. 

EDIT OPTIONS 

 

Undo & Redo  
 

Undo Shortcut: Control-Z 

Redo Shortcut: Shift-Control-Z 

Location: Edit Menu 

 

Undo is used to remove the previous change that you made to your audio. For example, you might apply an Echo effect and then decide 

that you don't want like the way it sounds -- use Undo to remove the effect entirely. 

Redo is used after Undo if you change your mind and decide that you really did, after all, like the echo effect and wish to re-apply it! 

 

Undo and Redo are thus very useful editing tools. Try using them like this: 

1) Apply an effect and then listen to your audio 

2) Undo the effect and then listen to your original audio again 

3) Redo the effect and listen to the audio with the effect once more 

4) Repeat steps 2 and 3 indefinitely until you decide whether you like the new effect or not! 

 

Only one level of undo and redo are stored by Wave Creator. If you apply an Echo effect and then apply a Chorus effect, for example, 

you won't be able to go back and undo the echo. 

 

Select All  
 

Select All Shortcut: Control-A 

Location: Edit Menu 

 

Use the Select All option to select the entire audio track in the current workspace. 

The following action (if selectively applicable) will be applied to the entire song in the workspace. 

 

NOTE: The default selection status depends on whether the selection is to be used for special audio effects or for the normal (non-audio) 

editing operations. 

That is if you have selected nothing (in the audio track), and then you apply an effect, like ECHO, then that effect will be applied to the 

entire track following the current cursor position. 

However, if you have selected nothing (as above) and then choose to perform a normal editing operation like CUT, the operation will not 

happen because the normal editing operations (cut, copy, clear, crop) will be disabled. 

 

Select None  
 

Location: Edit Menu 

 

Use the Select None option to deselect a (previously) selected portion of the audio track in the current workspace. In short, the selection 

status will return to its initial state: nothing selected. 

 

Cut, Copy, Paste, & Clear  
 

Location: Edit Menu 

Cut Shortcut: Control-X 

Copy Shortcut: Shift-Control-C 

Paste Shortcut: Control-V 

Clear Shortcut: Control-Delete 

 

Location: Edit Menu 

These commands work for the most part exactly as they would in a word processor.  In order to enable the commands, you must first 

select a portion of the sound clip in the Waveform Display Window (cf. Appendix "All About Selection "). 
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Cut removes the selection from your audio but stores the music data in scratch-pad memory.  The music data in scratch-pad memory can 

be "pasted" into another part of the same song or into a song opened in another workspace. 

Copy stores a copy of the music data specified by the selection in scratch-pad memory for later Pasting. 

Paste transfers the music data from the scratch-pad memory area into the sound clip.  It can be repeated multiple times. If there is NO 

music data in the scratch-pad memory area, then the PASTE option will be disabled. 

Clear removes the selection entirely, without copying it into memory at all. Clear is useful for quickly removing unwanted parts of your 

audio. 

 

Crop  
 

Location: Edit Menu 

Use Crop to remove unwanted audio before and after your audio selection. Crop is basically the opposite of Clear -- while Clear 

completely removes a selection from your audio, Crop removes everything except for the selection. 

 

Cut Selection to File  
 

Location: Edit Menu 

 

This option removes the selected portion from  the audio track and pastes the portion into another file which the user must specify during 

this operation. 

It telescopes the Cut option and the Copy Selection to File options for greater user convenience. 

 

Copy Selection to File  
 

Location: Edit Menu 

The Copy Selection to File command pastes your selection to a Wave-format file instead of into the Waveform Window. This is very 

useful if you only want to save a small portion of a large file to disk, or if you want to split a large file into several smaller tracks. To do 

so, use the Waveform Window to select the part of your audio that you want to save. Then select Copy Selection to File and choose a 

location on your hard drive. Repeat this process until you've split the large audio file into as many smaller files as you like. 

Another application for this menu option is to focus in on the area of interest. This reduces the time-expense in processing a really large 

audio file. When the segment is finally done to one's satisfaction, the modified segment can be re-introduced in the original audio file. 

 

Mute  
 

Location: Edit Menu 

The Mute function reduces the selected portion of sound to absolute silence. That is to say, the sound in question is replaced with silence 

of equal duration. This is unlike the Clear and Cut operations which remove the selected portion from the sound file. 

Let's say you have a song with some objectionable language. To mute a portion of your audio, follow these steps: 

1) Select the portion of the audio you wish to mute 

2) Select Mute in the Edit menu and then choose which channels to apply the mute to (if your audio is in stereo, you may mute either the 

left channel, the right channel, or both; if your audio is mono, you won't be able to select a channel) 

3) Click the OK command button. The portion of audio you selected has now been muted! 

Note: Wave Creator's Mute does not temporarily suppress output audio, as with a television remote control. Rather, it permanently mutes 

the audio itself. For this reason, Mute should be used only selectively to permanently remove unwanted portions of your sound clip. 

 

Trim Silence  
 

Location: Edit Menu 

The Trim Silence command allows you to remove unwanted patches of silence from your sound clip.  Please note that this operation 

removes the leading and trailing silent patches only! It does not remove intermediate pieces of silence. Wave Creator will automatically 

delete any leading and trailing portion of the sound track which is quieter than a given threshold leaving only the true signal. The 

threshold level used to determine a period of silence can be set and changed in a separate dialog box which pops up. Enter a value (as a 

percentage of the maximum signal) to determine the level below which any sound will be treated as silence. 

 

Insert Silence  
 

Location: Edit Menu 
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The Insert Silence command allows you to insert a "patch" of silence into the sound clip, at the indicated position with the duration of 

your choosing. 

 

First move the cursor to the position where you want to create the gap. Then click this menu option. A dialog box pops up asking you for 

the duration (in seconds) of the silent patch. Enter the duration and then click the OK command button. The silent patch will be inserted 

into the audio track at the cursor position. 

 

Change Format  
 

Location: Edit Menu 

A wave file may be recorded in a variety of formats, with each format representing a trade-off between file size and quality. Use the 

Change Format command to change the format of the file currently in memory. 

 

The supported sampling rates are: 8, 11.025, 12, 16, 22.05, 24, 32, 44.1, 48, 64, 88.2, and 96 KHz. 

You may switch between 8- or 16-bit depth, and mono or stereo (See the Recording Panel topic for more information about these 

settings.) 

 

 If you have opened or already recorded a low quality file (say, 8-bit resolution at a 22 KHz sampling rate), changing the format to a 

higher quality level will not improve the quality of the recording -- once the audio "information" is gone, there's no bringing it back. 

Conversely, switching to a lower quality level will decrease the quality of the recording, as you will be throwing away a certain amount 

of your audio information. 

 

There are practical reasons to convert to a lower-quality format: 

to reduce the size of a sound file. You may need to send a sound file over the Internet, or you may need to economize on disk space. 

That's when you convert to a lower quality format. (A case of half a loaf being better than none!) 

There are practical reasons to convert to a higher-quality format: 

To conform to working requirements and environments. You have a mono sound file. Unfortunately the research program you use to 

analyze audio files only accepts stereo sound files. That's when you convert from mono to stereo. 

 

VIEW OPTIONS 
  

Zoom In/Out  
 

Location: View Menu 

By selecting Zoom In or Zoom Out from the View menu, you can easily adjust the scale of your view in the Waveform Window. You 

can use the F2 and F3 function keys as shortcuts for Zoom In and  Zoom Out respectively. 

 

Alternatively you can use the Zoom control group to manipulate the scale of your view. The Zoom control group can be seen to the top 

right of the main waveform display window. The Magnifier icon with the plus (+) sign signifies Zoom In, and the one with the minus (-) 

sign signifies Zoom Out. 

 

Zoom to Selection  
 

Location: View Menu 

Zoom to Selection allows you to quickly and easily zoom in so that the Waveform Window is precisely filled by however much audio 

you have selected. To use this feature, simply select a portion of the audio in the Waveform Window and then select Zoom to Selection 

from the View menu. 

Pressing the F4 function key is a convenient keyboard shortcut for this feature. 

Alternatively you can use the Zoom control group to manipulate the scale of your view. The Zoom control group can be seen to the top 

right of the main waveform display window. The Magnifier icon with the plus (+) sign inside a dashed box signifies Zoom to Selection. 

 

Zoom to Extents  
 

Location: View Menu 

Zoom to Extents allows you to quickly and easily zoom out so that the Waveform Window is precisely filled by the waveform of the 

entire sound file. To use this feature, simply select Zoom to Extents from the View menu. 

Pressing the F5 function key is a convenient keyboard shortcut for this feature. 
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Alternatively you can use the Zoom control group to manipulate the scale of your view. The Zoom control group can be seen to the top 

right of the main waveform display window. The icon with two block arrowheads facing outwards signifies Zoom to Extents. 

 

Full screen  
 

Location: View Menu 

This menu option enlarges the program window to fill the entire screen. This effectively enlarges the waveform of the sound file. 

 

 

Minimum size  
 

Location: View Menu 

This menu option sizes the program window to its normal dimensions. This is the default program window size. This is a very convenient 

viewing mode, providing the user with the familiar floating "window" metaphor. 

 

Position displays  
 

Location: View Menu 

This menu option sets the units expressing the position of the sound file: the current position and the selection position. The program 

provides for two systems of position measurement: time and samples. Time positioning is expressed in minutes, seconds and thousandths 

of a second. Sample positioning is expressed as ordinal numbers specifying the sound sample 

When you click this menu option, the program presents you with a sub-menu offering you two further options: "Minutes/Seconds" and 

"Sample number". Choose the former for a position display in minutes and seconds; choose the latter for a position display showing 

sample numbers. 

 

Set Colors  
 

Location: View Menu 

This menu option provides the facility to change the color of most of the elements of the user interface. 

Click this menu option to bring up a dialog box. Go to the selection box captioned Display Elements. Click on the name of the element 

whose color is to be set. Next click the Change Color command button. Select the color you want to apply to the display element from the 

color palette. Click the palette's OK button. If you want to see the effect of the color change, click the Apply command button. 

Finally, when you're through setting colors, click the OK button to close the color dialog box. 

 

EFFECTS OPTIONS 

 
Note- some of the effects described below are only available with Record Cleaner or other special addon packages. 

 

Effects Overview  
 

Wave Creator allows you to apply special effects to an audio file or to a selection thereof. This implies that a file must be loaded in the 

primary workspace before you can apply an effect. 

Effects can be applied in two ways: 

1) From the sub-options available in the Effects menu option. 

2) By clicking one of the popular effects button (positioned just above the Waveform Display window).  

 

You will usually be presented with a dialog box giving several options that pertain to the effect you have selected. Remember: if you 

apply an effect and don't like it, you can undo the change by hitting Control-Z! 
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Equalize  
 

This effect gives you graphic-equalizer control over your wave file. The different sliders correspond to different frequency bands -- move 

a slider upwards to increase the loudness of that particular band, down to decrease its loudness.  The slider on the far left corresponds to 

the lowest frequencies, the slider on the far right the highest.   

The equalizer has three ranges: bass, midrange, and treble. The bass is covered by four bands (31-, 62-, 125-, and 250-Hz). The midrange 

is covered by four bands (500-, 1000-, 2000-, and 4000-Hz). The treble is covered by two bands (8kHz and 16kHz). 

Note that this equalizer feature affects the wave file directly, not just the way your speakers respond to it, and any changes you make will 

directly alter your wave file. 

 

Options 

Band gain: 

Each band has a slide control associated with it. The slide controls are marked with the center frequency of the band (expressed as Hz), 

and the band's gain (expressed in db or decibel). A gain of 0 db indicates no gain; positive values indicate amplification, negative values 

indicate attenuation. Please note that any scale marked in db is logarithmic, that is, non-linear. Note also that db expresses ratio. Hence it 

is not a unit of an absolute system of measurement, but is a unit of a relative system of measurement. 

The center position of the slider control represents 0 db, the topmost position represents +10 db, and the lowermost position represents -

10 db. 

Stereo Options - if the wave file is in stereo, you may select which channel(s) to apply the equalization to. 

 

Reverse  
 

This effect reverses the order of a sound, giving you the ability to hear what songs sound like played backwards, what people sound like 

talking in reverse, etc.  

 

Options 

If the wave file is in stereo, you may select which channel(s) to reverse. 

 

Normalize  
 

Normalization automatically increases the amplitude of a wave file, if necessary, so that its maximum loudness is actually "loud."  For 

example, if you have recorded the sound of a distant train whistle and it barely registers in the Waveform Window  (it is too quiet), you 

may use Normalize to automatically increase the sound's amplitude so that it really is loud. 

 

In the Waveform Window, Normalize is visible as a "heightening" of the sound's waveform, to the point where it just fills the window. 

 

Options 

If the wave file is in stereo, you may select which channel(s) to normalize. 

 

Flange  
 

This effect alters your audio to produce an odd techno-space-age swooshing kind of sound.  The best way to learn about Flange is to 

experiment with it -- remember that unwanted changes can be undone with Control-Z. 

 

In practice, Flange works somewhat similarly to Echo -- the original sound is mixed with a delayed version of the same sound.  But the 

delay is extremely small (Maximum Delay has a 6ms default), and it keeps changing -- 0ms, then 6ms, then 0ms, then 6ms, etc. 

 

Options 

Maximum Delay - controls the maximum amount of delay used by the flange effect. Experiment for best results. 

Delay Step - controls the rate at which the delay changes in time. Experiment for best results. 

Stereo Options - if the wave file is in stereo, you may select which channel(s) to apply the flange effect to. 

 

Chorus  
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The Chorus effect adds a second voice to your audio in a slightly shifted timeframe, resulting in an effect much like a chorus of more 

than one voice. Chorus works with all types of audio, but is particularly effective with the human voice. 

 

Options 

Maximum Delay - controls the maximum amount of delay used by the chorus effect. Experiment for best results. 

Delay Step - controls the rate at which the delay changes in time. Experiment for best results. 

 

Stereo Options - if the wave file is in stereo, you may select which channel(s) to apply the chorus effect to. 

 

Echo  
 

This effect generates an echo in your wave file by taking the original sound, reducing its volume, and mixing it back into your audio with 

a slight delay. As always, you should experiment to see what values work best for different types of files. 

 

 

Options 

Repeat Delay - the amount of delay time between the sound and its echo. 

Repeat Strength - the loudness of the echo, as a percentage of the original sound's loudness. 

Stereo Options - if the wave file is in stereo, you may select which channel(s) to apply the echo effect to. 

 

Amplify  
 

The Amplify effect lets you control the inherent 'loudness' of a sound. Use this effect to increase the amplification (loudness) of a quiet 

sound, or to decrease the amplification of a sound that is too loud. For example, you might record a whisper that's barely audible when 

played back, even with your amp at maximum volume. You can use Amplify to 'turn up' this sound until it's at a more reasonable level. 

 

Options 

Amplification Factor - the Amplification Factor controls the amount of amplification. A factor of 1 leads to no amplification, a factor of 2 

doubles the sound's amplitude, a factor of 0.5 reduces the amplitude by half, etc. 

 

Stereo Options - if the wave file is in stereo, you may select which channel(s) to apply the amplification to. 

 

Be sure you understand the difference between amplification and volume! The volume slider (and also any volume controls on your 

computer's speakers) only controls how loudly your audio is played back; the amplification effect is used to permanently and 

fundamentally alter the inherent loudness of your audio. 

 

Also be sure that you don't overdo your amplification and end up with a wave file that's clipped. 

 

Fade Out  
 

Fade Out allows you to gradually decrease the amplitude of your audio, producing a gentle fading effect. This is very useful, for example, 

if you Crop a song short but don't want the song to sound like it's been abruptly cut off. You would generally use Fade Out at the end of a 

song or piece of audio, but you can apply it to any part of your audio. To apply a fade to only a part of your audio, first select the audio 

you would like faded in the Waveform Window and then press the Fade Out button. If you would like to apply the fade to all the audio in 

memory, make sure that no part of your audio is selected and then press the Fade Out button. 

 

 

Options: 

Maximum - This number is the amplitude of your audio at the end of the fade. To end your fade at zero amplitude (volume), choose 0.00. 

To fade to half standard volume, choose 0.50. The fade will always begin at full amplitude. 

Stereo Options - If the wave file is in stereo, you may select which channel(s) to apply the fade to. 

 

Mix  
 

The Mix button allows you to mix two separate sound files (of the same type) together. 
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To mix two sounds together, open the first wave file in Wave Creator and then move the blinking cursor to the point where the second 

wave file will be mixed.  Then push the Mix button and select the second sound. The files will be mixed, beginning at the cursor. We can 

mix the files in two different ways: back-to-back, and merged. 

 

Back-to-back:  

If the cursor is at the end of the first wave file, then the second wave file will be appended to the first wave file. 

 

Merged or Overlapped: 

If the cursor is somewhere in the middle of the first wave file, then the second wave file will be mixed with the first wave file. You will 

now hear sound from both files in the overlapping portions of the two files. 

 

NOTE: To insert the audio contents of one file into another file, you will have to use the "copy-from and paste-into" technique. Please 

refer to Cut, Copy, Paste, & Clear  

 

Wave Creator supports the mixing of stereo and mono sounds.  If you would like the mixed sound to be in stereo, open the stereo file first 

and then mix in the mono sound -- the mono sound will be spread to both channels and the resulting mixed sound will be in stereo.  If 

you would like the mixed sound to be in mono, open the mono file first and then mix in the stereo sound -- the stereo sound will be 

"compressed" into a single channel and the resulting mixed sound will be in mono. 

 

Options: None. 

 

Fade In  
 

Fade In allows you to gradually increase the amplitude of your audio, producing a gentle fading effect. This is generally used at the 

beginning of a song or piece of audio, but you can apply it to any part of your audio. To apply a fade to only a part of your audio, first 

select the audio you would like faded in the Waveform Window and then press the Fade In button. If you would like to apply the fade to 

all the audio in memory, make sure that no part of your audio is selected and then press the Fade In button. 

 

Options 

Maximum - This number is the amplitude of your audio at the beginning of the fade. To start your fade at zero amplitude (volume), 

choose 0.00. To fade from half standard volume, choose 0.50. The fade will always end at full amplitude. 

Stereo Options - If the wave file is in stereo, you may select which channel(s) to apply the fade to. 

 

Bass Boost 
 

Makes the low frequencies louder to emphasize the bass and bass drum in music.  

 

Low Pass Filter 
 

A low pass filter removes all sound above a set frequency.  It is useful in removing certain kinds of hiss. 

 

Notch Filter 
 

This filter removes all audio in a specified frequency band in a wave file. 

 

Pop and Click Removal 
 

This tool uses sophisticated DSP algorithms to detect abrupt changes in the waveform that indicate a pop or a click.  It then removes just 

the portion that is causing the undesired sound. 

 

Sound Warmer 
 

The Sound Warmer works by adding a little bit of resonance to the sound.  It's like a simple reverb. 

 

Noise Gate 
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A noise gate is a filter that analyzes a sound, looking for sections that have only noise, and filters all sound until there is some useful 

audio signal.  It is especially helpful for soft sections that have certain kinds of noise.  

 

Center Channel Removal 

 
Often the vocals are recorded equally in both left and right channels on a stereo recording, making them sound like they are in the center.  

Center Channel Removal removes sound that is present equally in both channels and may eliminate the vocals from some recordings.  

 

Mono To Stereo 

 
Our Mono To Stereo tool takes a single channel of sound, splits it in two, and modifies the resulting data so it sounds like it was recorded 

in stereo. 

 

Note Scrubber 

 
Note Scrubber allows you to use a tool called an Equalizer (sometimes referred to as an EQ) to reduce the amount of sound in a particular 

range of notes. 

WINDOW  

 

This menu option shows the status of the windows managed by the program. There are three main windows: Rip, Edit, and Burn. Only 1 

out of these 3 is active, indicated by a small black dot to the left of the window's name. 

There are any number of workspace windows including none. If there is one or more workspace windows, then again, only one of them is 

the active (primary) workspace; this fact is indicated by a small black dot to the left of the window's (workspace file's) name. 

 

INTERNET OPTIONS 

Find new music  
 

This menu option guides you to Web links which cater to music lovers. Most of these sites offer downloads of free music; some require 

registration for access. Lots of options to sample good music here! 

 

Download New Effects  
 

Users of the Wave Creator can download updates for the numerous effects in their audio effects library. 

 

Blaze Audio  
 

Visit our web-site for more information about our latest offerings, go one-on-one with musicologists in our discussion zone, help yourself 

to our support and tutorials, shop at our web-store! 

Our web-site and ezones:  

Home 

Products 

Free Downloads 

Support 

Tutorials 

Discussions 

 

HELP  

 

This menu option has the following sub-options. 

1) Help Index   (Shortcut: function key <F1>) 
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2) Help Contents 

3) Online Tutorials 

4) About Wave Creator 

 

CONTROL PANELS  

 
The edit mode interface is conveniently organized as a set of functional panels. These panels are: 

Playback control panel 

Position indicator panel 

Recording control panel 

Volume control panel 

Volume display panel 

Waveform panel 

Effects control panel 

Zoom control cluster 

Workspace status bar 

Program status bar 

 

Playback buttons  
 

The Playback Control Panel groups the Playback Buttons for your convenience. It is the topmost panel in the stack at the left of the 

program window. 

 

 
 

These buttons function similarly to the transport buttons on most VCRs and electronic audio players. 

These buttons are arranged in two rows: 

Stop, Play from Begin, and Play in the top row, and Start, Rewind, Fast Forward, End in the second row.  

 

The functions of the buttons are as follows: 

 

 
 

Stop 

Icon: A black square. 

This button stops playback. 

 

 
 

Play from the Beginning 

Icon: A rightward pointing block arrowhead with a vertical bar ("end-marker") to its left. 

This button commences playback of your audio from the beginning of the file. This button first rewinds the audio to the beginning and 

then commences playback. 

 

 

 
 

Play 
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Icon: A rightward pointing block arrowhead. 

This button commences playback of your audio. Playback will begin at the location of the green cursor (see Waveform Window for more 

information on the cursor). 

Once playback begins, the Play button changes its persona to that of a Pause button. The icon changes to a pair of parallel vertical bars. 

Press this Pause button to pause playback. Press it again to resume playback. 

 

 

 
 

(Go to) Start of Tape 

Icon: A leftward pointing block arrowhead with a vertical bar ("end-marker") to its left. 

This button move the cursor to the beginning of your audio file. 

 

 
 

Rewind 

Icon: A double block arrowhead pointing left. 

This button moves the playback cursor a fixed interval backwards. It functions only when playback is taking place or is paused (not when 

it's stopped). 

 

 

 
 

Fast Forward 

Icon: A double block arrowhead pointing right. 

This button moves the playback cursor a fixed interval forwards. It functions only when playback is taking place or is paused (not when 

it's stopped). 

 

 

 
 

(Go to) End 

Icon: A rightward pointing block arrowhead with a vertical bar ("end-marker") to its right. 

This button moves the cursor to the end of your audio file. 

 

Position indicators  
 

The position indicator panel appears just below the playback control panel. 

 
This panel has 3 indicators: 

(1) Current position; (2) Start of selection; (3) End of selection. 

The position indicators help the user to establish a reference point in the audio file. 

The position is indicated in either one of two units: (1) time units; and (2) sample units.  

Time is expressed in minutes, seconds, and milliseconds (1 millisecond = 1/1000 of a second) 

Sample position is expressed as an ordinal number. 

The correlation between sample position and time is given by the sampling rate. 

 

The current position indicator indicates the exact point which is currently playing or which will play when playing is resumed. 
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The visual indicator for this position is the vertical green cursor which extends across the height of the display window. This cursor 

moves from left to right when the audio file is played. 

 

The selection indicators are set only when the user selects a portion of the audio track. 

 

 
 

The start indicator marks the point from where the selected portion begins. 

The end indicator marks the point at which the selected portion ends. 

Both the positions are editable by the user. 

 

Recording panel  
 

The recording control panel appears just below the position indicator panel. 

 

 
 

All the recording-related controls are grouped in this panel for the user's convenience. 

The Recording Control Panel has three buttons and two slider controls. 

 

Record button  
 

The Record button is prominently positioned at the top left of this panel. It is iconized as a solid red dot. 

 

 
 

Click this button to start recording. Immediately the icon changes to a solid green dot. A flashing sign states that recording is active. 

Click the record button once more to stop recording. 

Note the activity of the position display. 
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Recording Source  
 

The recording source button changes the source which will be used to record an audio track. 

A short caption just above this button indicates the current recording source. If you want to change this recording source then click this 

button.  

 

 
 

The recording source changes, and this is reflected by the change in the caption above the button. Briefly, select CD as the recording 

source if you want to record songs from an audio CD (using your system's CD-ROM drive). Select Line In (or Aux In) if you have some 

audio equipment connected to your sound card's Line/Aux In socket. Select Stereo Mix if you want to record whatever is playing on your 

sound card (from some other program perhaps). Select Microphone to record from a microphone. 

 

Record settings  
 

 
 

Click this button to set the recording parameters. 

A dialog box assists the user in setting these parameters. 

 

 
 

The parameters are the Sampling Rate, the Bit Rate (sample resolution), and the number of Channels. The sampling rate, the sample 

resolution (bit rate), and the number of channels (monophonic/stereophonic) are available from selection lists. Choose these parameters 

carefully as they will determine the quality of the sound file and its size. 

 

Recording level slider  
 

The Recording Level control appears as a vertical slider in the Recording Control panel. 
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Use this slider control to adjust the level of the incoming (source) signal during a recording session. Use this in conjunction with the LED 

Level meter (Volume Display) for distortion-free recording. 

 

Recording balance slider  
 

The Recording Balance control appears as a horizontal slider in the Recording Control panel.  

 

 
 

Use this slider control to adjust the balance of the incoming (source) signal during a recording session. This is effective for stereo (2 

channel) signals only! 

 

Volume control panel  
 

The Volume Control Panel is the fourth panel in the stack at the left of the program window.  

 

 
 

The Volume Control Panel has two slider controls. 

 

The Playback Volume control appears as a vertical slider in the Volume Control panel.  

 

 
 

Use this slider control to adjust the loudness (volume) of the sound during playback. 

 

The Playback Balance control appears as a horizontal slider in the Volume Control panel.  
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Use this slider control to adjust the balance of the output sound during playback. This is effective for stereo (2 channel) signals only! 

 

Volume display  
 

This panel is to the immediate right of the Volume Control panel. 

 

 
 

Wave Creator has a twin column of LEDs to indicate the playback/recording level. 

During playback, the lights of the Volume Display indicate the loudness of the sound being played; during recording, they indicate the 

level (strength) of the sound being recorded. If the sound is in stereo, the loudness of the left and right channels may differ. 

 

To avoid getting distortion while recording, you should adjust your recording level (in the Recording Control Panel) so that the Volume 

Indicators only rarely max out in the red range. If the red lights are constantly lit up, you'll need to reduce your recording level. 

Conversely, you'll probably need to increase the recording level if the input sound is so quiet that most of the lights are never going on. 

Immediately above the level meters are 'clipping' indicators, one for each channel. These indicators flash red when a signal exceeds the 

maximum signal level that can be handled by your sound card. It's OK if these clipping indicators flash on occasionally; but if they're on 

for extended periods then you should reduce the level of the signal. 

 

The Volume Display indicates the inherent loudness of the sound, not the volume of your computer's speakers. Adjusting your 

computer's speakers will have no effect on this display. See Amplify to adjust the inherent 'loudness' of your audio. 

 

THE WAVEFORM DISPLAY PANEL 

 

The waveform display panel is Wave Creator's way of visually displaying the sounds you edit, giving you a graphical view of your audio 

that's so essential for careful editing work.  
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The waveform display panel has two windows: 

a) the waveform display window; and, 

b) the waveform overview window. 

The waveform display window is your primary tool for making selections, applying effects, monitoring playback, and interacting with 

your wave file in general. 

The waveform overview window allows you to move and scan over larger spans of the audio track. 

 

 

Waveform Display  
 

 
 

The waveform display window is arranged so that the far left part of the display indicates the beginning point of the sound, with time 

increasing to the right. Audio will thus play from left to right in this window. 

The horizontal blue line represents absolute silence. This is the baseline for the signal waveform. If your audio is in stereo, you'll see two 

parallel baselines representing stereo sound's left and right channels -- otherwise, with mono audio you'll only see a single baseline. 

The other blue lines represent the amplitude of your audio; in other words, increasing deviation above and below the baselines indicates 

increasing sound intensity. 

Translation: Big squiggly lines mean loud audio; little squiggly lines mean quiet audio. 
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Vertical Green Line 

The flashing green cursor represents a precise point in time -- while playing back a sound, you can see the cursor move to the right as the 

playback progresses.  

You may also move this cursor manually. 

i) Point-and-click with the mouse to move the cursor exactly where you want it. 

ii) The cursor can be moved in steps of 0.02 seconds with the help of the cursor movement keys on your keyboard: tap the right arrow 

key to move the cursor right, tap the left arrow key to move the cursor left. 

iii) For larger (0.2 second) steps, press the Control key (captioned "Ctrl") on the keyboard along with the appropriate right/left arrow key. 

iv) Press the Home key to go directly to the beginning of the track, and press the End key to go directly to the end of the track. 

 

The Current Position Indicator shows exactly where the cursor is in the current file. 

 

Selecting Audio 

The Waveform Window may be used to select a portion of your audio. In fact, this is perhaps the most important function of the window 

-- by allowing you to select a small part of your audio, you can selectively apply any of Wave Creator's effects wherever you want them 

in your file. To make a selection, merely click and drag in the Waveform Window. A highlighted area will indicate your current 

selection; to clear the selection entirely, merely click once anywhere in the window. 

 

 
 

Another way of making a selection is to press the Shift key on the keyboard whilst at the same time pressing the appropriate right/left 

arrow key. Pressing the Shift and Control key together with the appropriate arrow key to make the selection in larger (0.2s) steps. 

 

Editing Cursor  
 

Vertical Green Line 

The flashing green cursor represents a precise point in time -- while playing back a sound, you can see the cursor move to the right as the 

playback progresses.  

You may also move this cursor manually. 

i) Point-and-click with the mouse to move the cursor exactly where you want it. 

ii) The cursor can be moved in steps of 0.02 seconds with the help of the cursor movement keys on your keyboard: tap the right arrow 

key to move the cursor right, tap the left arrow key to move the cursor left. 

iii) For larger (0.2 second) steps, press the Control key (captioned "Ctrl") on the keyboard along gwith the appropriate right/left arrow 

key. 

iv) Press the Home key to go directly to the beginning of the track, and press the End key to go directly to the end of the track. 

 

The Current Position Indicator shows exactly where the cursor is in the current file. 

 

THE WAVEFORM OVERVIEW WINDOW  
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The Wave Overview Window displays a small panoramic view of the entire wave file and shows you at a glance which portion of the file 

is currently being displayed in the main Waveform Window. 

 

The two vertical gray bars represent (and control) the limits of what is displayed above, in the Waveform Window.  You may move these 

bars individually, by clicking on them and dragging, or you may move them together by clicking on the area between them and dragging.  

This is an effective way of navigating along an extended wave file. 

 

If you do not see any vertical gray bars, they are probably hidden at the far left and right ends of the window.  Try clicking and dragging 

them more to the center. Alternatively, use the magnifier tool (Zoom In, press the F2 function key) to get a close up view of the 

waveform. That will make those vertical bars come out and be noticed! 

At the extreme left and right of the Waveform Overview window are simple slide controls, one facing right, the other facing left. Each 

slide control pans the audio waveform in the main Waveform Display window in its respective direction. This will happen only if the 

sound waveform exceeds the limits of the waveform display window. 

 

THE EFFECTS CONTROL SET  

 

The Effects Control set consists of 6 command buttons. The set is positioned just above the main waveform display window.  

 

 
 

The 5 effects controlled by this set are: Equalize, Fade, Normalize, Echo, and Mix. Click the appropriate button to apply the effect.  

These effects are fully described in the Effects' section. 

The sixth command button is captioned "More...". Click on this command button to see a drop-down list of all the available effects. Click 

on the name of an effect in the drop-down list to activate it. 

 

ZOOM CONTROL CLUSTER  

 

The Zoom Control cluster consists of 4 control buttons. The cluster is positioned just above the main waveform display window, in the 

right half of the program window. 

 

 
 

The Magnifier icon with the plus (+) sign inside a dashed box signifies the Zoom to Selection command button. Click the command 

button adorned with this icon to quickly and easily zoom in so that the Waveform Window is precisely filled by however much audio you 

have selected. 

The Magnifier icon with the plus (+) sign signifies the Zoom In command button, and the one with the minus (-) sign signifies the Zoom 

Out command button. Click the Zoom In command button to enlarge the view. Click the Zoom Out command button to reduce the view. 

The icon with two block arrowheads facing outwards signifies the Zoom to Extents command button. Click the command button adorned 

with this icon to quickly and easily zoom out so that the Waveform Window is precisely filled by the waveform of the entire sound file. 

This is the default zoom mode. 
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THE EDITING TIMELINE  

 

This bar is located at the bottom of the Waveform Display Window.  

 

 
 

The scale uses small tics and big tics. There are 10 small tics to 1 big tic. 

The timeline scale is graded according to the zoom factor in the units specified for the Position Displays. The minor grade is 1-tenth of 

the major grade. 

 

In this way, the highest resolution at maximum zoom (ratio = 1:1) is 2 milliseconds or 100 samples (major grade) and 0.2 milliseconds or 

10 samples (minor grade). 

 

This timeline is very convenient for editing. You can tell the position of an audio segment at a single glance. You can estimate the "size" 

of an audio chunk just by reading the timeline values at the beginning and ending of the chunk. 

 

THE WORKSPACE STATUS BAR  

 

 
 

The Workspace Status bar shows the number of current workspaces. This bar stretches right across from the left edge of the program 

window to the right edge, just below the Volume Control panel and the Waveform Overview window. It lies just above the Program 

Status bar. 

Each workspace represents an audio file which is available (loaded) for editing. The name of the file appears on the "tab" of its associated 

workspace. Only one of these workspaces is active at a given time; the others are passive. The active workspace is called the primary 

workspace. A white background indicates the primary workspace, a gray background indicates a non-primary workspace. Clicking the 

workspace tab makes it the primary workspace. As each file is opened, it is automatically granted the primary status. 

 

THE PROGRAM STATUS BAR  

 

 
 

The Program Status bar runs right across the bottom edge of the program window. It lies just below the Workspace Status bar. The 

Program Status bar displays facts about the primary workspace. The first fact is the sampling rate. The second is the sampling resolution. 

The third is the number of channels. The fourth is the ratio of the number of samples in the display window and the total number of 

samples in the workspace. This ratio changes whenever the zoom factor of the view changes. The final fact is the total length of the 

workspace measured in time units. 
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 EDITING AND ADDING 
EFFECTS________________ 
 

This section will show you how to edit a sound file (Wave format) using the program’s standard editing functions, and how to add the 

various sound effects provided by Wave Creator.  

 

A sound effect will be applied to the current sound file; this means that a sound file must already be open for an effect to be applied to it. 

[Caution! Make a backup copy of your valuable sound files BEFORE applying these effects!] 

[Tip: To recover from an unintended action, click the Edit option (second from the left) on the menu, then click Undo (the first 

from the top). Alternatively, just press the Control-key and the Z-key (they're on the keyboard - bottom left) at the same time; 

and then release both keys.] 

General topics:  

These are a few topics that will come up quite frequently as you use Wave Creator's editor to work your "music magic" on sound files. 

Making a selection: 

The effects provided by Wave Creator can be applied to the entire song or to a part of the song. If you want to affect just a part of the 

song, then you have to indicate that part to Wave Creator. This is called "making a selection" (See "All About Selection" in the 

appendices for a detailed explanation). 

First of all, you must open a sound file. Click the File option on the menu at the top of the window, then click the Open sub-option (the 

second from the top).  

Mark the portion of the song by clicking on the waveform display of the song. This marks the start of the selection. Drag the mouse to 

another part of the waveform, and end the drag. The portion of the song thus marked will show up in reverse video, that is, the waveform 

will be in black and the background is in white. 

That's it! The selection is made. 

 

 
 

Opening a Wave-format sound file: 

Click the File option (the very first one) on the menu. Then click the Open... sub-option (the second from the top). Wave Creator will 

present you with a file selection dialog box. Specify the folder containing the sound file you want to play. The specify/select the sound 

file. Click the OK command button. 

After a few seconds of processing (preparing the workspace and waveform), Wave Creator will display the waveform of the specified 

sound file in the waveform display window. 

<give reference to tutorial on how to open a file> 

This open file is called the current song file. 

 

Playing the current song: 

Locate the Playback Control Panel in the window. It is in the left upper half of the window. The Play control button is in the top row, the 

third from the left. Click it to play the current song. 
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Playing the selected portion of the current song: 

Make sure that a selection is active, that is, you have already marked a part of the song (please refer to the general topic "Making a 

selection" above). Locate the Playback Control Panel in the window. It is in the left upper half of the window. The Play control button is 

in the top row, the third from the left. Click it to play the selected portion of the current song. 

Removing silences 
 

Wave Creator gets rid of "silent" passages in the leading and trailing sections of the audio track with one simple menu option: Trim 

Silence! Just open the Edit menu and go down to the all but last sub-option, "Trim Silence". Click this sub-option. You'll be presented 

with a dialog box asking for the silence level (as a % of maximum). Enter something like 2%-5%. Click the OK command button. Done! 

In a jiffy, you'll see the dead air disappear from the audio track! 

PLEASE NOTE:  
(1) Do NOT apply this function whilst a selection is active! Retire any selection before using this function! 

(2) Trim Silence ONLY removes silent passages in the leading and trailing sections of the audio track. 

 

Getting rid of dead-air or low-amplitude "noise" (in the middle of the audio track) 

Select the portion of the audio track which has the dead air or silent passage. Press the "Delete" key ("Del" on your keyboard). Done! 

Or, instead of using the "Delete/Del" key, go up to the menu bar, open the Edit menu, then click the "Clear" sub-option. 

 

PLEASE NOTE: 

(1) "Clear" and "Cut" are similar functions except for one important difference... the part that is removed with Clear is not 
available for "pasting" elsewhere, whereas the part removed with Cut can be pasted into the same or another audio track. 

 

 

Inserting silence  
 

If you find you have to create a "gap" between two sections of an audio track, you'll need to plug in some silence! 

First decide the duration of the gap you want to create. Second, position the audio editing cursor at the point where you want to create the 

gap. Go to the main menu's Edit option. Then click the Insert Silence sub-option. A dialog box pops up. Enter the duration of the gap (in 

seconds) in the text-entry box. Click the OK command button. The gap will be created. 

 

Adding Echo 
 

Select the section (see “Making a Selection” on page XX) of the song you want to apply the echo effect to.   

Click the Echo button.  Wave Creator presents you with a dialog box, asking for Repeat delay and Repeat strength. It also asks you to 

select the channel you want to apply the effect to.  For now accept the default values for Repeat delay and Repeat strength. 

Click the appropriate channel selection radio button. 

Click OK to apply the effect, Cancel to abort the operation. 

Wave Creator goes to work and applies the effect to the selected segment! 

Done! 

 

To hear the echo effect, just click the Play button on the Transport Control panel. Please refer to the general topic "Playing the current 

song" for details. 

 

You can apply other effects in the same way. Experiment with the parameters as you go. Remember, you can always recover from a 

mistake by pressing the Control-key and the Z-key simultaneously (Ctrl+Z). 

 

Apply EQ  
 

This function allows you to strengthen and/or weaken certain frequency bands of the current song. 
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First select a "section" of the song you want to equalize. This is called "making a selection". 

If you want to know how to do that, please refer to the general topic "Making a selection" above. 

Then click the Equalize button. 

Wave Creator provides the user with a 10-band graphic equalizer, mono and stereo. A dialog box asks you to select the channel you want 

to equalize; for now select both channels. 

The equalizer has three ranges: bass, midrange, and treble. The bass is covered by four bands (31-, 62-, 125-, and 250-Hz). The midrange 

is covered by four bands (500-, 1000-, 2000-, and 4000-Hz). The treble is covered by two bands (8kHz and 16kHz). 

The 10 bands are centered at 31, 62, 125, 250, 500 Hz, and 1, 2, 4, 8 and 16kHz. 

Each band is controlled by a slider which can boost or cut the amplitude of the band by 10 db. 

Drag the slider of the band you want to equalize. Upwards increases the amplitude, downwards decreases the amplitude. Move the mouse 

pointer over the slider you want to move, press the left mouse button AND KEEP IT PRESSED! Now move the mouse in the appropriate 

direction. When you are satisfied that the band slider is at the desired level, release the mouse button. 

Do this (press, drag, release the slider) for all the bands that you want to adjust. 

Click OK to apply the equalization, Cancel to abort the operation. 

Wave Creator goes to work and equalizes the selected segment! 

 

To hear the effect of the equalization, just click the Play button on the Transport Control panel. Please refer to the general topic "Playing 

the current song" for details. 

 

To know more about equalization, click here ! 

 

Audio effects  
 

EXPLANATION OF THE VARIOUS EFFECTS 

Echo: Sound is multiply repeated after a small but noticeable delay with diminishing amplitude (sound strength). 

Chorus: A single voice begins to sound like many voices together. 

Flange: A sound rapidly changes in pitch, alternatively above and below its natural pitch, with diminishing amplitude. 

Normalize: An overall automatically-computed increase in amplitude (sound strength) of a song or part of a song. The increase is 

determined by the ratio of the strongest signal (of the part under consideration) to the maximum signal level. 

Amplify: An overall user-specified increase in amplitude (sound strength). 

Fade In: The sound strength is initially reduced to a user-specified level and then gradually increased to its "normal" level. 

Fade Out: The sound strength is gradually decreased from its "normal" level to a user-specified level. 

Reverse: The sound is played backwards. ("ago" sounds like "oga") 

Mix: The sound from another file is overlaid the current song. The current song is extended if necessary. 

Equalize: The amplitude is modified according to the pitch (frequency band).
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DEFINITIONS_______ 

 
Selection  
 

The following applies to the subject of selecting a portion of the audio track during editing. 

 

Making a selection: 

The edit functions and audio effects provided by Wave Creator can be applied to the entire song or to a part of the song. If you want to 

affect just a part of the song, then you have to indicate that part to Wave Creator. This is called "making a selection". 

First of all, you must open a sound file. Click the File option on the menu at the top of the window, then click the Open sub-option (the 

second from the top).  

Mark the portion of the song by clicking on the waveform display of the song. This marks the start of the selection. Drag the mouse to 

another part of the waveform, and end the drag. The portion of the song thus marked will show up with its foreground and background 

colors as specified in the "Selection Waveform" and "Selection Background" option of the View menu's "Set Colors" sub-option. 

 

Drag means: move the mouse, keeping the mouse button pressed. Just release the mouse button to end the drag. 

Retiring a selection: 

After a selection has outlived its usefulness, what then? How do I get rid of the selection? Do I delete the selection? NO! 

No, you don't get rid of the selection, or delete it or remove it or anything of that sort! Those terms and phrases may give a person the 

wrong idea, and the user may actually delete a portion of his carefully prepared sound file when that wasn't his or our intention at all! 

Instead we simply "de-select" or "unselect" the selection! How? Just click inside the Waveform Display window, and voila! The selection 

is gone! 

You can also use the menu option "Select None" for this. Go to the Edit menu, and then click the Select None sub-option. The selection 

will be retired.  

 

Alternative method of making a selection: 

First of all, you must open a sound file. Click the File option on the menu at the top of the window, then click the Open sub-option (the 

second from the top).  

Mark the portion of the song by clicking on the waveform display of the song. This marks the start of the selection.  

Now press the key labeled [SHIFT] on your keyboard. Keeping it pressed, press the right or left cursor key (it is the one with an arrow 

pointing in the appropriate direction) as required. You will notice the foreground and background colors changing as specified in the 

"Selection Waveform" and "Selection Background" option of the View menu's "Set Colors" sub-option. 

Just release the SHIFT key (and the cursor key) when you want to end the selection. 

 

Analog and Digital Representation  
 

Naturally occurring sound, as well as the output of musical instruments and sound systems, is a sequence of waves or waveforms. A 

wave represents the time-progressive strength of the sound as a displacement or excursion from the silent or quiescent state. It is possible 

to measure and express the displacement numerically. The popular word for "numerical" is "digital". The waveform-like representation is 

called "analog" representation as opposed to "digitized" or digital representation. The analog wave is digitized by an analog-to-digital 

converter (ADC) circuit. Conversely, the digitized wave is rendered as a natural (analog) sound by a digital-to-analog converter (DAC) 

circuit.  The sound card of your computer contains an ADC and its complementary DAC. 

The sound from a drum, a singer's voice... these are sound signals. These sound signals are converted via the singer's microphone or a 

pick-up on the instrument to electrical/electronic signals. The electrical signals faithfully follow the original sound signals; hence we call 

these electrical signals "analog" signals. 

We need the converted electrical signals if we are going to use electrical/electronic equipment to process, transmit or store the original 

sound signals. 

Analog signals are better expressed as "linear" signals, whereas digital signals are better expressed as "quantified" or "non-linear" signals. 

 

 

More information: 

Sampling  

Wave and MP3 formats  

Quality after A-D conversion 

Sampling  
 

Sampling is a function of the ADC. 
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The ADC grabs the electrical analog signal and processes it to determine its amplitude at that point of time. This is called "sampling". 

The amplitude is expressed as a numerical value, the sample value or "sample". 

There are two sub-issues involved here. One is the time between signal evaluations or, to put it another way, the number of evaluations 

per unit time. This is called the sampling rate and it is expressed as samples per second (S/s or Hz). The practical unit is kilosamples per 

second (kS/s or kHz) which indicates thousands of samples per second. The other issue is the accuracy and precision of the numerical 

evaluation and representation. This is called the resolution of the sample value. It is expressed by the maximum number of "binary digits" 

(= 'bits') used to evaluate the sample. 

The most widely used sampling methodology for ADCs is called "Pulse Code Modulation" or 'PCM'. 

 

The sampling rate and the sample resolution directly impact on the quality of the "digitized" sound. The original analog signal is a 

continuous series of values representing a sound continuum; hence, this is also called a linear (or breakless) representation. The digitized 

representation, on the other hand, is a series of values representing discrete sounds a finite interval apart. The smaller the interval, the 

greater is the approximation (fidelity) of the digitized sound to the original sound. Hence a higher sampling rate equates to better sound 

quality. 

The original sound value may change in amplitude ever so slightly from one instant to the next. If the interval between samples is very 

small then the amplitude variation can be very small indeed. On the other hand, the maximum sound signal that can be "expected" may 

be thousands of times greater than the inter-sample variation. This range of the smallest variation in sound to the maximum sound 

expected is called the dynamic range of the digitized sound. It is limited or determined by the sample resolution. The greater the sample 

resolution, the greater is the dynamic range, and, consequently the  fidelity of the digitized signal to the original sound. 

 

 

More information: 

Analog and Digital Representation  

Wave and MP3 formats  

Quality after A-D conversion 

Wave and MP3 formats  
 

The term "format" indicates the coding pattern used to store data in a file. 

The term "audio file" indicates a file that contains data used to represent sounds, music, and songs. 

Audio files come in a variety of formats. The two most popular audio formats are: "Wave" file format (synonymous usage: Wave file and 

Wave format), and MPEG file format (abbreviated in this documentation as MP3). Both formats are digitized representations of "analog" 

sounds. A simple difference between them is that a Wave file represents the sounds (waveforms) as they occurred in real-time, whereas 

an MP3 file is essentially a compressed version of a Wave file. Consequently an MP3 file is much, much shorter than a Wave file. 

The MP3 compression is performed according to a specification laid down by the Moving Picture Experts Group (MPEG, pronounced 

'em-peg'). This compression is performed with the help of a  "codec", so called because it helps to compress and decompress an audio 

file. 

The MP3 format is a highly compressed type of audio that takes up far less disk space than Wave files. It is also a "lossy" compression 

algorithm, meaning that (in theory) your MP3 files will not sound quite so good as your wave files. Practically speaking, you probably 

won't notice the difference unless you choose a really low bitrate for the MP3 conversion! 

 

Parameters for Wave-format files: 

Sampling methodology: 

This describes how the analog signal was sampled to derive the digitized value. This is almost always PCM. 

Sampling rate:  

The number of samples evaluated per second. Practical unit is kilo hertz (kHz). Common rates are 12 kHz, 24kHz, and 44.1kHz. 

Sampling resolution: 

The number of "bits" used to express the numerical value of the sample. The unit is bits per sample (bpS). Common resolutions are 8bpS 

and 16bpS or simply 8-bit and 16-bit. 

Number of channels: 

The number of parallel data streams which compose a single performance. Common numbers are 1 (monophonic) and 2 (stereophonic). 

 

Parameters for MP3-format files: 

Codec: 

The compression-decompression algorithm (methodology) used to record and playback the MP3 audio file. 

Bitrate: 

This is the compression rate. It is the number of bits which will be used to express 1 second of sound. The practical unit is kilobits per 

second (kbps). Common bitrates are 128kbps and 256kbps, but severe compression can go right down to 20kbps. 

Sampling rate: 

The sampling rate is the number of sound samples generated per second. The practical unit is kilohertz (kHz). Typical rates are: 48kHz, 

44.1kHz, and 32kHz. 
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As a simple comparison of an audio file before and after compression: 

Sampling resolution: 16bpS 

Sampling frequency: 44.1kHz 

Size for 1 second of audio:  

16bpS X 44100S = 705600 bits 

With MP3 compression: 

@128kbps:=> 128000b; comp. ratio = 5.5:1 

@ 20kbps:=>  20000b; comp. ratio = 35.25:1 

This is based on simple arithmetic; the actual compression ratio can go much higher than that depending on the content of the song! In 

practical terms the typical compression ratio is around twice the arithmetically-derived ratio ! 

 

[NOTE: Some Wave-format files are indeed compressed, but these (generally) use proprietary compression algorithms and hence are not 

popular.] 

 

More information: 

Analog and Digital Representation  

MP3 Codecs  

 

For more information about MPEG, visit: 

http://www.cselt.it/mpeg/ 
 

Quality after A-D conversion  
 

An analog waveform is characterized by a smooth and continuous change in its amplitude.  The quality of the converted (digitized) 

waveform is determined by how closely it resembles the original (analog) waveform. The first major difference arises from the sampling 

interval. The word "interval" implies that the resultant waveform is NOT continuous. A digitized waveform can never be continuous, but 

it can approach that state by reducing the interval between samples. In other words, the digitized output will approach the continuity of 

the analog waveform if the sampling rate is increased sufficiently. 

The second difference arises from using a limited set of integers to describe the samples. To elaborate: Suppose we use a set of 2000 

integers to describe a dynamic range of 2000 millivolts (mv). That works out to 1 number for 1 mv (2000mv/2000 numbers). In other 

words we cannot describe (resolve) differences smaller than 1 mv! We can improve the resolution by using larger numbers (numbers 

with more digits) to describe the amplitude of the signal waveform. The digitized output will approach the smoothness of the analog 

waveform if we increase the number size. 

These two parameters (sampling rate and sampling resolution) define the quality of the digitized signal. The higher the value of these 

parameters, the better is the quality. At the same time it must be noted that the higher the value of these parameters, the larger is the size 

of the resultant file! It must also be noted that high resolution, high speed DACs are (comparatively) expensive devices. 

So it's basically a tug-of-war (or compromise) between quality on the one hand and a combination of file size and device cost on the 

other. 

A stereo file has 2 channels of sound. This means that a stereo file is double the size of a monophonic (single channel) file. 

 

Compression adds yet another factor to the question of quality. The most popular compression methodology nowadays is called MP3. At 

its best compression rate of 20kbps (Windows ACM codec) the quality is noticeably poor, and at 32kbps (Lame encoding) it is downright 

intolerable! 

 

As a test we ripped a track from an up-market audio CD at 44100Hz, 16bit, stereo (a). The file size was about 28MB. 

Then the file was resampled at 11025Hz, 16bit, stereo (b). The file size was about 7MB. 

Next, the (original) file was MP3-compressed at 20kbps using the Windows ACM codec (c). The file size was 400 kB! 

Finally,  the (original) file was MP3-compressed at 128kbps using the Windows ACM codec (d). The file size was 2.5MB. 

    File size  Compression Format    Quality 

(a)   28000kB  ----- Original      100% 

(b)    7000kB    4:1 Wave, 11kHz   

Poor 

(c)400kB   70:1 MP3, 20kbps   

Poor 

(d)    2500kB     11:1 MP3, 128kbps   99% 

The quality of (b) and (c) was almost the same, poor. Whereas (b) exhibited a slight raspiness, a form of amplitude distortion, (c) 

exhibited frequency distortion. 

And (d) was PRACTICALLY the same as the original, with a 11:1 disk economy to boot! 

The secret appears to be in the fact that MP3 advances the sampling rate in slabs as the bitrate increases. At a bitrate of 32kbps the 

sampling rate is 11kHz, at 64kbps the SR is 22kHz, and at 96kbps the SR is 44kHz. 

So the best deal is to compress using MP3 with a bitrate of 96kbps or higher. 
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MP3 Codecs  
 

'Codec' stands for "compression/decompression". It's basically a small program that's installed on your computer system which then 

allows the operating system (Windows) to compress and/or decompress audio to and from certain formats. The compression bitrate is a 

function of the codec installed on your computer system. 

 

If you intend to Decode or Encode MP3 files, then you need a special software program called a codec. Two popular codecs are the 

Fraunhofer codec (Professional or Advanced) and the LAME encoder (its not a codec really!).  

 

The common Windows ACM Default codec allows a compression bitrate ranging from 20 kilobits per second to 128 kilobits per second, 

whereas the Lame encoder lets you select from 32 kilobits per second to 320 kilobits per second. 

 

When you first run Wave Creator, the software will determine if you need to download any software components. If so, it will point you 

to a website from where you may download the required components. 

 

In case you have difficulty obtaining an MP3 codec, please contact our support site at support@blazeaudio.com.  

Or drop by our website at www.blazeaudio.com and visit our download section. 
 

For more information about MPEG, visit http://www.cselt.it/mpeg/ 
 

Clipping  
 

Clipping is a form of amplitudinal distortion exhibited by signals (any signal which exhibits wave behavior). This is caused by placing a 

limit or cap on the representation or expression of the signal's amplitude. As an example suppose we measure a signal over a period of 5 

minutes. The amplitude varies from 0 to 500 units. However our measuring device displays only 2 digits, that is its maximum reading is 

99 units. It is easy to see that the measuring device is actually giving us a FALSE reading of the signal whenever the signal strength 

exceeds 99 units! 

This takes place in tape decks, audio amplifiers, and similar equipment. 

Clipping distortion of a song is easily observed and is very disturbing. It produces a raspy sound. Clipping causes other forms of 

distortion too! 

 

Burning a CD  
 

A CD is used much the same as a floppy disk or a hard disk, in that we use all three of them to store our (digital) data. However, the way 

we store data on a CD is very different from the way we store data on a hard disk or floppy disk. Add to that the fact that the CD is 

supposedly a ROM (Read-Only memory) storage device, and we are in fact contradicting that definition by WRITING to the CD!  

The first difference in a floppy/hard disk and a CD is their organization. The former is organized as a huge number of sectors, tracks 

(cylinders), and heads. This facilitates resizing of data files, deletion of data files, reusing disk space freed by deleting files. In short, this 

organization is appropriate for a dynamic data environment. This is very suitable for the floppy and hard disks, because they are primarily 

viewed as rewritable media used in active service. That is, we use them in everyday work to hold data as it is being generated and 

manipulated. We assume they will undergo many write-rewrite cycles in their lifetime. On the other hand a CD is primarily viewed as an 

archival Read-Only medium. A CD is organized as a continuous stream of data from start to finish, and it is physically written as a single 

spiral track. 

So data has to be written to the CD in (seemingly) one burst. This makes the operation very resource hungry and time-critical! The data 

to be written to the CD is first assembled on the hard disk exactly as it will appear on the CD. This means that 600-700MB of the hard 

disk is reserved for the burning process. Secondly, a sufficiently large memory buffer is assigned to transfer the data from the hard disk to 

the CD. Special care has to be taken to ensure that the buffer has sufficient data to transfer to the CD when writing is taking place (this is 

called buffer under-run prevention). The buffer is progressively updated while data is being written to the CD. This requires heavy CPU 

usage during the burn. Hence all the crucial resources of the computer system (viz. disk space, working memory space, and CPU time) 

are strained. 

If there is any interruption during the burn, then the CD will end up with improperly written data. This is why it is advisable (not 

mandatory!)  to close all other tasks (except for Wave Creator) when you burn a CD.
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Control Reference 

 

Waveform Display Window  
 

This is the Waveform Display Window.  

 

 
 

The waveform traces of the audio track are displayed in this window. The user can visually examine the nuances of the music (or sound).  

 

Waveform Overview Window  
 

This is the Waveform Overview Window. This window shows the waveform of the whole audio track. 

 

 
 

It also tracks and displays the portion of the waveform being displayed in the main waveform display window. You can use this tracking 

window to change the focus of the waveform display window. 

 

Cursor  
 

This vertical green line is the audio position cursor. 

 
 

It indicates the position at which the current audio  track is playing or is stopped. 

To reposition the cursor, all you have to do is click the left mouse button at the desired point of the audio track. 
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Left Channel  
 

This is the waveform trace of the left channel of the audio track. 

 

 
This trace will be displayed only in the case of a stereo track. In a mono audio track only one waveform trace will be displayed. 

 

Right Channel  
 

This is the waveform trace of the right channel of the audio track. 

 

 
This trace will be displayed only in the case of a stereo track. In a mono audio track only one waveform trace will be displayed. 

 

Zoom to Selection  
 

This is the Zoom to Selection button.  

 

 
 

This requires that the user select a portion of the audio track before clicking this button. This button performs a Zoom In so that the 

selected portion of the audio track is adjusted to fit fully in the Waveform Display window. 

 

Zoom to Extents  
 

This is the Zoom to Extents button. 

 

 
 

This button performs a full Zoom Out. When you click this button, the audio track is adjusted to fit fully in the Waveform Display 

window. 

 

Zoom In  
 

This is the Zoom In button.  
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Click this button to increase the magnification of the view. You will now see less of the audio track in the waveform display window but 

the waveform will be expanded. 

 

Zoom Out  
 

This is the Zoom Out button.  

 

 
 

Click this button to reduce the magnification of the view. You will now see more of the audio track in the waveform display window but 

the waveform will be cramped. 

 

Play  
 

This is the Play button.  

 

 
 

This button begins playing the current audio track from its current position.  

It disables the Play-from-Beginning button, and enables the Fast Forward and Fast Rewind buttons. 

When the user clicks this button, it changes its persona to that of a Pause button. Clicking it in this persona pauses the audio track. Click 

it once again to resume playing the audio track. 

 

Play from Beginning  
 

This button begins playing the audio track right from the beginning.  

 

 
 

That's why it is sometimes called the Play-from-Beginning (or Start) button. 

It disables the Play button, and enables the Fast Forward and Fast Rewind buttons. 

When the user clicks this button, it changes its persona to that of a Pause button. Clicking it in this persona pauses the audio track. Click 

it once again to resume playing the audio track. 

 

End Play  
 

This is the Stop button.  

 

 
} 

It ends the current playing session. 

It disables the Fast Forward and Fast Rewind buttons. At the same time it enables the Play-from-Beginning button. 

 

Beginning of Track  
 

This button moves to the beginning of the current audio track. 

 

 
 

It is usually called the BOT or Beginning-of-Tape (or Track) button, though some prefer Start-of-Tape. 
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End of Track  
 

This button moves to the end of the current audio track. 

 

 
 

It is usually called the EOT or End-of-Tape (or Track) button. 

 

Fast Rewind  
 

This button (Fast Rewind) rewinds the audio track by a fixed amount. 

 
 

This button is enabled only when an audio track is playing. 

 

Fast Forward  
 

This button (Fast Forward) advances the audio track by a fixed amount. 

 

 
 

This button is enabled only when an audio track is playing. 

 

Current Position  
 

This readout shows the position at which the current audio  track is playing or is stopped. 

 

 
 

Depending on the setting of the Position Displays in the View Menu, the position is expressed in minutes, seconds and thousandths of a 

second, or as a sample number. 

 

Start of Selection   
 

This readout shows the position at which the selected portion of the current audio  track begins. 

 

 
 

Depending on the setting of the Position Displays in the View Menu, the position is expressed in minutes, seconds and thousandths of a 

second, or as a sample number. 

 

End of Selection   
 

This readout shows the position at which the selected portion of the current audio  track ends. 
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If the user has not selected any portion of the audio track, then this reading will be 0. 

Depending on the setting of the Position Displays in the View Menu, the position is expressed in minutes, seconds and thousandths of a 

second, or as a sample number. 

 

Record  
 

Click this button to start recording. 

 

 
  

When the program is in the recording mode, the red spot on the face of this button changes to green. 

Equalizer  
 

This button applies equalization to the sound in the selected range. 

 

 
 

Wave Creator comes loaded with a 10-band graphic equalizer. The equalizer provides 10db of amplification/attenuation. 

Click this button to call up the equalizer. Then set the boost/cut for each band. 

 

This button applies the Fade out effect to the audio track. 

 

 
 

This effect progressively reduces the strength of the sound to the user specified terminal value. 

 

Normalize  
 

This button applies the Normalize effect to the audio track. 

 

 
 

This effect maximizes the strength of the strongest sound in the selected range and computes the ratio of the change. Then all the sound 

in the selected range is amplified proportionately. 

 

Normalize is very useful if you are burning a mix CD with tracks from different original CDs- you can use it to match the volumes. 

 

Echo  
 

This button applies the Echo effect to the audio track. 

 

 
 

This effect duplicates the sound after a sensible delay and produces an audible result from which it takes its name. 

 

Mix file  
 

This button activates the audio Mix function. 

 

 
 

Click this button if you want to include the audio from another file into the audio of the current workspace at the current position. 
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Recording Level Slider  
 

This is the recording level control slider. 

 

 
 

This slider sets the level of the incoming signal. This slider is effective only for recording. 

 

Recording Balance Slider  
 

This is the recording balance control slider. 

 

 
 

This slider changes the relative level of the left and right channels during recording. 

This slider is effective only for recording in stereo. 

 

Recording Source  
 

This is the recording source selection button. 

 

 
 

This command button changes the source from which audio will be recorded. 

Just click it to change the source to the next available one. It cycles through the list of available audio input devices. 

 

Recording Format  
 

The the record format settings button allows the user to change the format in which the current recording or workspace data will be 

saved.  The format parameters are Sampling Rate, Sampling Resolution, and number of Channels. 

 

Current Recording Source  
 

This is the name of the source which will be used for recording. 
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To change it, click the button captioned Rec Source (just below). 

 

Playback Volume Slider  
 

This is the playback volume control slider. 

 

 
 

This slider sets the volume of the audio track during playback. This slider is effective only for playback. 

 

Playback Balance Slider  
 

This is the playback balance control slider. 

 

 
 

Level Meter (Rec/Play)  
 

These are dual-channel LED-type level meters.  

 

 
 

Pan Left  
 

This is the Pan Left control. 

 

 
 

This slider changes the relative level of 

the left and right channels during 

playback. 

This slider is effective only for 

playback in stereo 

They reflect the level of the incoming signal during recording and 

the volume level during playback. 

Two clipping indicators (one for each channel) light up whenever 

the channel signal exceeds the standard maximum value. 
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This control pans the waveform in the waveform display window to the left. This button will work only when the waveform is zoomed 

in. 

 

Pan Right  
 

This is the Pan Right control. 

 
 

This control pans the waveform in the waveform display window to the right. This button will work only when the waveform is zoomed 

in. 

 

 

Program Status  
 

This is the Program Status bar. 

 

 
 

It shows the format of the primary audio track, the zoom ratio of the waveform display window, and the duration of the primary audio 

track in time units. 

Menu 
 

This is the main menu bar of the edit window. 

 

 
 

To activate a menu option, move the mouse pointer to the desired option and click it with the left mouse button. 

 

Editing Timeline  
 

This is located at the bottom of the Waveform Display Window.  

 

 
 

The scale uses small tics and big tics. There are 10 small tics to 1 big tic. 

The timeline scale is graded according to the zoom factor in the units specified for the Position Displays. The minor grade is 1-tenth of 

the major grade. 

 

In this way, the highest resolution at maximum zoom (ratio = 1:1) is 2 milliseconds or 100 samples (major grade) and 0.2 milliseconds or 

10 samples (minor grade). 

 

What's New in Version 3.0 
 
1.FULL-SCREEN editing mode, accessed from the View menu. Now you can examine the waveform traces in greater detail. 

2.Timeline in the editing mode. Now you can correlate the sound event and its time of occurrence. 

3.A facility to INSERT a patch of silence in the audio file. Great for creating "gaps" between passages. 
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4.A facility to change the colors of most of the items of the interface... from the Waveform Display window to the clipping 
lights! This takes care of monitor aberrations where items are "hard-to-see" because of poor contrast. Of course you may 
also change the colors for a better visual appeal!  Choose Set Colors in the View menu.  Click Revert in the Change Colors 
dialog box to undo your changes. 

5.Precision selection of a waveform. Press the SHIFT key and the Right (or Left) cursor key on your keyboard to highlight 
(select) a portion of the waveform in the waveform display window. You can then apply an effect or edit the selected portion 
of the waveform. 

6.Revert option under File menu. Now you can discard all the changes you have made to the song in the active workspace, 
and reload the audio data from the last saved state. 

7.A new menu option to "Cut Selection to File" under Edit menu. With a single click of the mouse button you can 
simultaneously remove the selected portion and save it as a separate file. 

8.Facility to select the input/output device (open the File menu, navigate to Preferences and click the Devices sub-option). 
This is useful when there are multiple input/output devices installed on the user's system. 

9.Extended range of Sampling Rates: Wave Creator now supports Wave format files with sampling rates of: 8000, 11025, 
12000, 16000, 22050, 24000, 32000, 44100, 48000, 64000, 88200, and 96000 (all in Hz). 

10.Keyboard shortcuts to speed up your work.  

 


